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Warnings and Notices

The following issues occurred during the automated portion of your configuration and must be addressed before proceeding.
« Some of the clients in your environment may need access to the SAS/GRAPH Java applets to view graphical output generated by SAS processes. If
so, add the APPLETLOC option to the sasv9_usermods.cfg file located in each SAS Application Server context directory specifying the location to be
used in generating graphical output. APPLETLOC should point to a network accessible copy of the SAS/GRAPH Java applets.

Since your deployment includes the SAS Web Infrastructure Platform, the applets can be made available (you must use the correct host and port)
via:

-APPLETLOC "http://mid-tier-server:mid-tier-port/sasweb/graph"
The default ports are:
JBoss: 8080
WebLogic: 7001
WebSphere: 9080
« /sas/ebiserver/Lev1/SASApp/PooledWorkspaceServer - Read access is required by the SAS Spawned Servers account, sassrv.
« /sas/ebiserver/Lev1/SASApp/PooledWorkspaceServer/Logs - Read access is required by the SAS Spawned Servers account, sassrv.
« /sas/ebiserver/Lev1/SASApp/PooledWorkspaceServer/Logs - Write access is required by the SAS Spawned Servers account, sassrv.
« /sas/ebiserver/Lev1/SASApp/PooledWorkspaceServer/sasuser - Read access is required by the SAS Spawned Servers account, sassrv.
« /sas/ebiserver/Lev1/SASApp/PooledWorkspaceServer/sasv9.cfg - Read access is required by the SAS Spawned Servers account, sassrv.
« /sas/ebiserver/Lev1/SASApp/PooledWorkspaceServer/sasv9_usermods.cfg - Read access is required by the SAS Spawned Servers account, sassrv.

« /sas/ebiserver/Lev1/SASApp/PooledWorkspaceServer/autoexec.sas - Read access is required by the SAS Spawned Servers account, sassrv.

« /sas/ebiserver/Lev1/SASApp/PooledWorkspaceServer/autoexec_usermods.sas - Read access is required by the SAS Spawned Servers account,
sassrv.

» /sas/ebiserver/Lev1/SASApp/PooledWorkspaceServer/PooledWorkspaceServer.sh - Read access is required by the SAS Spawned Servers account,
sassrv.

« /sas/ebiserver/Lev1/SASApp/PooledWorkspaceServer/PooledWorkspaceServer_usermods.sh - Read access is required by the SAS Spawned
Servers account, sassrv.

« /sas/ebiserver/Lev1/SASApp/PooledWorkspaceServer/logconfig.xml - Read access is required by the SAS Spawned Servers account, sassrv.
« /sas/ebiserver/Lev1/SASApp/StoredProcessServer - Read access is required by the SAS Spawned Servers account, sassrv.

« /sas/ebiserver/Lev1/SASApp/StoredProcessServer/Logs - Read access is required by the SAS Spawned Servers account, sassrv.

« /sas/ebiserver/Lev1/SASApp/StoredProcessServer/Logs - Write access is required by the SAS Spawned Servers account, sassrv.

« /sas/ebiserver/Lev1/SASApp/StoredProcessServer/sasuser - Read access is required by the SAS Spawned Servers account, sassrv.

» /sas/ebiserver/Lev1/SASApp/StoredProcessServer/sasv9.cfg - Read access is required by the SAS Spawned Servers account, sassrv.
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» /sas/ebiserver/Lev1/SASApp/StoredProcessServer/sasv9_usermods.cfg - Read access is required by the SAS Spawned Servers account, sassrv.

« /sas/ebiserver/Lev1/SASApp/StoredProcessServer/autoexec.sas - Read access is required by the SAS Spawned Servers account, sassrv.

« /sas/ebiserver/Lev1/SASApp/StoredProcessServer/autoexec_usermods.sas - Read access is required by the SAS Spawned Servers account, sassrv.
« /sas/ebiserver/Lev1/SASApp/StoredProcessServer/StoredProcessServer.sh - Read access is required by the SAS Spawned Servers account, sassrv.

« /sas/ebiserver/Lev1/SASApp/StoredProcessServer/StoredProcessServer_usermods.sh - Read access is required by the SAS Spawned Servers
account, sassrv.

« /sas/ebiserver/Lev1/SASApp/StoredProcessServer/logconfig.xml - Read access is required by the SAS Spawned Servers account, sassrv.

« Permissions on the logs directory (/sas/ebiserver/Lev1/Web/Logs) are currently set at 777. We strongly recommend that you narrow access to this
directory. To facilitate creation of logs, make sure that the SAS Installer (sas) and the invoker of the Web application server can write to this directory.
To facilitate appropriate use of the logs, make sure that administrators can see the directory.

SAS Management Console
SAS Management Console is required to complete many of the following steps.

/sas/SASHome/SASManagementConsole/9.3/sasmc
For easier access, the installation directory /sas/SASHome/SASManagementConsole/9.3 can be placed in the executable path
environment. Likewise, aliases or symbolic links can be created to reference the command.

User ID SAS Administrator user ID

Password Enter the password you created in the SAS Deployment Wizard.

Startup
command

SAS Application Servers

SASMeta - Metadata Server

Host
machine

Port 8561

HOSTNAME.example.com

[sas/ebiserver/Lev1/SASMeta/MetadataServer/Logs
For more details about the initial logging configuration and how to modify it, see "Administering Logging for SAS Servers" in the SAS
Intelligence Platform: System Administration Guide at http://support.sas.com/93administration.

Log
directory

Execution Shell script
type /sas/ebiserver/Lev1/SASMeta/MetadataServer/MetadataServer.sh

Notes:

* The metadata server is configured to perform unassisted metadata server backups. The backups are performed at 1 a.m. server-local time and
stored in the /sas/ebiserver/Lev1/SASMeta/MetadataServer/Backups directory. Backups are retained for seven days. To learn about the metadata
server backup facility, see "Backing Up the SAS Metadata Server" in the SAS Intelligence Platform: System Administration Guide at
http://support.sas.com/93administration.

« The metadata server is configured to use journaling. The journal is a high-speed disk file that is used in conjunction with the new server backup
facility to support unassisted metadata server backups and provide roll-forward recovery of transactions beyond a backup to a specified point in time.

« The metadata server is configured to send an alert e-mail message to noreply@localhost in the event of a system, backup, or recovery failure. You
can test that the alert-email notification subsystem is configured properly by opening the active metadata server's Properties sheet in the SAS
Management Console Metadata Manager and sending a test message. If the system is configured properly, you will receive a test e-mail from
SASMeta - Metadata Server ebiserver - Lev1 <noreply@localhost>. To change or add an alert e-mail recipient, you must modify the value of the
option in the omaconfig.xml file. Aftering editing the file, you must stop and restart the metadata server for the change to take effect.

SASApp - OLAP Server

Host
machine

Port 5452

[sas/ebiserver/Lev1/SASApp/OLAPServer/Logs
For more details about the initial logging configuration and how to modify it, see "Administering Logging for SAS Servers" in the SAS
Intelligence Platform: System Administration Guide at http://support.sas.com/93administration.

HOSTNAME.example.com

Log
directory

1. In the SAS Management Console, on the Plug-ins tab, select "+" to expand the Server Manager node.
Validation 2. Expand SASApp.
steps 3. Highlight the SASApp - Logical OLAP Server.
4. Right mouse click this server and select Validate. You should see a Validation Successful message.
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Execution Shell script
type /sas/ebiserver/Lev1/SASApp/OLAPServer/OLAPServer.sh

SASApp - Stored Process Server

Host
machine

Port 8602

HOSTNAME.example.com

[sas/ebiserver/Lev1/SASApp/StoredProcessServer/Logs
For more details about the initial logging configuration and how to modify it, see "Administering Logging for SAS Servers" in the SAS
Intelligence Platform: System Administration Guide at http://support.sas.com/93administration.

directory

1. In the SAS Management Console, on the Plug-ins tab, select "+" to expand the Server Manager node.
Validation 2. Expand SASApp.
steps 3. Highlight the SASApp - Logical Stored Process Server.
4. Right mouse click this server and select Validate. You should see a Validation Successful message.

SASMeta - Workspace Server

Host S TNAME.example.com
machine
Validation The SASMeta - Workspace Server should be used for only a few designated administrative tasks. It is appropriate to defer validation of this
server until you have set up the SAS users who will perform these tasks. This server requires an external account and is available to only
steps L
the SAS Administrators group.
Notes:

* The /sas/ebiserver/Lev1/SASMeta/WorkspaceServer/Logs directory is intended to serve as a placeholder for workspace server logs. Workspace
server logs may be directed to this directory in the event that your SAS or IT administrator enables logging. The following default attributes are
associated with the Logs directory:

o Universal read, write or execute access is disabled for the directory in order to comply with default installation security requirements
o Execution of a workspace server does not populate the Logs directory
o The Logs directory serves as a placeholder should you enable logging for workspace servers

Enabling workspace server logging should be carefully considered, due to the proliferation of workspace server logs, as well as the requirement to
grant universal write access to the Logs directory. To enable workspace server logging, perform the following steps:

o Enable read, write and execute access to the Logs directory

o Modify the workspace server logconfig.xml to enable the desired levels of logging

o Alternately, enable the logconfig.trace.xml logging file to capture workspace server diagnostic logging

SASApp - Workspace Server

Host
machine

Port 8592

HOSTNAME.example.com

[sas/ebiserver/Lev1/SASApp/WorkspaceServer/Logs
For more details about the initial logging configuration and how to modify it, see "Administering Logging for SAS Servers" in the SAS
Intelligence Platform: System Administration Guide at http://support.sas.com/93administration.

Log
directory

1. In the SAS Management Console, on the Plug-ins tab, select "+" to expand the Server Manager node.

2. Expand SASApp.

3. Highlight the SASApp - Logical Workspace Server.

4. Right mouse click this server and select Validate (you can enter sasdemo or the SAS Spawned Servers account for the user ID). You
should see a Validation Successful message.

Validation
steps

Notes:

* The /sas/ebiserver/Lev1/SASApp/WorkspaceServer/Logs directory is intended to serve as a placeholder for workspace server logs. Workspace
server logs may be directed to this directory in the event that your SAS or IT administrator enables logging. The following default attributes are
associated with the Logs directory:

o Universal read, write or execute access is disabled for the directory in order to comply with default installation security requirements
o Execution of a workspace server does not populate the Logs directory
o The Logs directory serves as a placeholder should you enable logging for workspace servers

Enabling workspace server logging should be carefully considered, due to the proliferation of workspace server logs, as well as the requirement to
grant universal write access to the Logs directory. To enable workspace server logging, perform the following steps:

o Enable read, write and execute access to the Logs directory

o Modify the workspace server logconfig.xml to enable the desired levels of logging
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o Alternately, enable the logconfig.trace.xml logging file to capture workspace server diagnostic logging

SAS Bl Report Services Workspace Configuration

Name ="SASApp - wrstemp"

1. In SAS Management Console, on the Plug-ins tab, select the "+" to expand the Data Library Manager node.
2. Select "+" to expand Libraries.

3. Select the library listed above.

4. Right mouse click this library and select Properties.

5. Click the Options tab and locate the path to the library in the Selected items text box.

Query Cache Review the documentation provided to determine if permissions need to be modified for the library or directory to which the library
Library points.

1. For details, view the http://support.sas.com/93administration and refer to the document called SAS Intelligence Platform 9.3:
Web Application Administration Guide.

2. See the section called Improving the Performance of SAS Web Report Studio.

3. This section will contain a list of Suggestions for Improving the Performance of SAS Web Report Studio. Go to the information
titted "Using the Query Cache".

4. Refer to the subsection called Security Considerations for the Query Cache Libraries for information regarding permissions.

Name ="SASApp - wrsdist"

1. In SAS Management Console, on the Plug-ins tab, select the "+" to expand the Data Library Manager node.
2. Select "+" to expand Libraries.

3. Select the library listed above.

4. Right mouse click this library and select Properties.

5. Click the Options tab and locate the path to the library in the Selected items text box.

Distribution
Library Review the documentation provided to determine if permissions need to be modified for the library or directory to which the library
points.
1. For details, view the http://support.sas.com/93administration and refer to the document called SAS Intelligence Platform 9.3:
Web Application Administration Guide.
2. See the section called Pre-generated Reports From SAS Web Report Studio.
3. Refer to the subsection called Verifying Permissions for the Distribution Library for information regarding permissions.
1. In SAS Management Console, on the Plug-ins tab, select "+" to expand the Data Library Manager node.
2. Verify the libraries named above are listed under the Data Library Manager.
3. In SAS Management Console, on the Plug-ins tab, select "+" to expand the Application Management node.
Validation 4. Select "+" to expand the Configuration Manager

steps 5. Highlight Bl Rep Svc Wkspace Config 4.3
6. Right mouse click and select Properties.
7. Click the Settings tab.
8. Validate the query cache library and the distribution library. They should match the libraries listed under Data Libraries.

SAS Bl Report Services

[sas/ebiserver/Lev1/Applications/SASBIReportServices4.3/Logs
Log directory For more details about how to modify your log format and to see what logging entails, see the SAS Intelligence Platform 9.3: Web
Application Administration Guide at http://support.sas.com/93administration.

Java Batch

Server Name ="SASApp - BRM Java Batch Server

Configuration Configuration Directory = "/sas/ebiserver/Lev1/Applications/SASBIReportServices4.3"

Validation
steps Java Batch Server
1. In SAS Management Console, on the Plug-ins tab, select "+" to expand the Server Manager node.
2. Select "+" to expand SASApp.
3. Select "+" to expand the SASApp - Logical SAS Java Batch Server.
4. Verify the existence of the java batch server(s) referenced above.
5. Right mouse click this server and select Properties.
6. Click the Options tab.
7. Validate the command line by examining the parameter values and verifying file locations and the repository name.
Local Services
1. In SAS Management Console, on the Plug-ins tab, select "+" to expand the Foundation Services Manager node.
2. Select "+" to expand the SASBIReportServices4.3 Local Services Definition.
3. Select "+" to expand Core.
4. Select the Logging Service.
5. Right mouse button and choose Properties.
6. Click the Service Configuration tab.
7. Click the Configuration button.
8. Verify the logging contexts.
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9. Refer to the logging documentation at the link specified above for details.

outputgen.ini file

1. The file outputgen.ini may need to be modified. This file is located in the install folder /sas/SASHome/SASBIReportServices/4.31.

2. The following default settings for Java command line options appear in this file: java.net.preferlPv4Stack=true and
java.net.preferlPv6Addresses=false.

3. If the system is configured to use IPv6, these values must be changed to: java.net.preferlPv4Stack=false and
java.net.preferlPv6Addresses=true.

SASApp - Pooled Workspace Server

Host machine HOSTNAME.example.com
Port 8702

1. In the SAS Management Console, on the Plug-ins tab, select "+" to expand the Server Manager node.
2. Expand SASApp.

3. Highlight the SASApp - Logical Pooled Workspace Server.

4. Right mouse click this server and select Validate. You should see a Validation Successful message.

Validation steps

SASMeta - SAS DATA Step Batch Server

Host

. HOSTNAME.example.com
machine

[sas/ebiserver/Levi/SASMeta/BatchServer/Logs
For more details about the initial logging configuration and how to modify it, see "Administering Logging for SAS Servers" in the SAS
Intelligence Platform: System Administration Guide at http://support.sas.com/93administration.

Log
directory

1. Execute the following command:
/sas/ebiserver/Lev1/SASMeta/BatchServer/sasbatch.sh
2. If SAS starts successfully, the DATA step batch server has been validated.

Validation
steps

SAS Spawners

Object Spawner

Host
machine

Port 8582

[sas/ebiserver/Lev1/ObjectSpawner/Logs
For more details about the initial logging configuration and how to modify it, see "Administering Logging for SAS Servers" in the SAS
Intelligence Platform: System Administration Guide at http://support.sas.com/93administration.

HOSTNAME.example.com

Log
directory

Execution Shell script
type /sas/ebiserver/Lev1/ObjectSpawner/ObjectSpawner.sh

SAS Framework Data Server
Host

machine
Port 22031

HOSTNAME.example.com

[sas/ebiserver/Lev1/FrameworkServer/dffedsvrcfg/Logs
For more details about the initial logging configuration and how to modify it, see "Administering Logging for SAS Servers" in the SAS
Intelligence Platform: System Administration Guide at http://support.sas.com/93administration.

Log
directory

1. In the SAS Management Console, on the Plug-ins tab, select "+" to expand the Server Manager node.
Validation 2. Expand FrameworkServer - Logical SAS Framework Data Server.
steps 3. Highlight the FrameworkServer - SAS Framework Data Server.
4. Right mouse click this server and select Validate. You should see a Validation Successful message.

Execution Shell script
type /sas/ebiserver/Lev1/FrameworkServer/dffedsvrcfg/dffedsvrcfg.sh
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SAS Deployment Tester Server

Host machine HOSTNAME.example.com
Port 10021

Execution Shell script
type /sas/ebiserver/Lev1/DeploymentTesterServer/DeploymentTesterServer.sh

1. In SAS Management Console, on the Plug-ins tab, select "+" to expand the Application Management node.
2. Select "+" to expand Deployment Tester
3. Highlight the host machine: HOSTNAME.example.com
Validation 4. Right mouse click and select Run All Test Suites.
steps 5. Select "+" to expand the Results.
6. Validate the results for each test suite. All tests should pass.

If you are prompted for credentials, select the "Help" button in the Credentials dialog box to display the accounts that can be used for
each test suite.

Notes:

* Deployment Tester Server is used to run tests on SAS products and servers to validate functionality and proper operation. The Deployment Tester
Server in conjunction with the Deployment Tester SASMC plug-in allows for tests to be executed on remote systems from a single SASMC instance.

« When you are done validating your deployment with SAS Deployment Tester, the Deployment Tester Server can safely be shut down without affecting
the rest of your SAS deployment. Deployment Tester Server is a stand-alone server, independent of the rest of SAS, that can be started and used
periodically to verify the health of your SAS deployment. You should consider verifying the health of your SAS deployment after initial installation,
after applying maintenance and hot fixes, or when you make any other significant changes to the deployment.

* More detailed information on validating your SAS deployment with Deployment Tester can be found in the "Using the Deployment Tester" section of
the SAS 9.3 Intelligence Platform: System Administration Guide, which is available at http://www.support.sas.com/93administration.

Operating System Services Scheduling Server

Host
machine

Port 8451

Log
directory

HOSTNAME.example.com

[sas/ebiserver/Lev1/SchedulingServer/Logs

1. In the SAS Management Console, on the Plug-ins tab, select "+" to expand the Server Manager node.
Validation 2. Highlight Operating System Services - HOSTNAME.example.com.
steps 3. Right mouse click this server and select Validate (you can enter sasdemo or the SAS Spawned Servers account for the user ID). You
should see a Validation Successful message.

SAS Bl Lineage Scheduling Server

Java Batch

s Name = "SASApp - BIL Java Batch Server"
erver

Configuration Configuration Directory = "/sas/ebiserver/Lev1/Applications/SASBILineage4.3"

Java Batch Server
. In SAS Management Console, on the Plug-ins tab, select "+" to expand the Server Manager node.
. Select "+" to expand SASApp.
. Select "+" to expand the SASApp - Logical SAS Java Batch Server.
. Verify the existence of the Java batch server referenced above.
. Right mouse click this server and select Properties.
. Click the Options tab.
. Validate the command line.

NO R WN -~

Validation steps ScanDriver.sh file

1. Verify the existence of the file ScanDriver.sh. This file is located in the configuration folder
/sas/ebiserver/Lev1/Applications/SASBILineage4.3.

Software Component
. In SAS Management Console, on the Folders tab, select "+" to expand the System folder.
. Select "+" to expand the Applications folder.
. Select "+" to expand the SAS Bl Lineage Scheduling Server folder.
. Verify the existence of the Bl Lineage Sched Svr 4.3 software component.

AOWON=-
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SAS Web Infrastructure Platform Scheduling Services

Log directory /sas/ebiserver/Lev1/Web/Logs

JES Java Batch
Server

Name = "SASApp - JES Java Batch Server"

Configuration Directory = "/sas/ebiserver/Lev1/Web/Applications/SASWIPSchedulingServices9.3"

Configuration Deployment Directory = "/sas/ebiserver/Lev1/WIPSchedBatch"

JES Java Batch Server
. In SAS Management Console, on the Plug-ins tab, select "+" to expand the Server Manager node.
. Select "+" to expand SASApp.
. Select "+" to expand the SASApp - Logical SAS Java Batch Server.
. Verify the existence of the java batch server(s) referenced above.
. Right mouse click this server and select Properties.
. Click the Options tab.
. Validate that the command line and arguments are appropriate for this java batch server.

NO R WN -~

Validation steps

servicetrigger.ini file
. The file servicetrigger.ini may need to be modified. This file is located in the install folder
/sas/SASHome/SASWeblnfrastructurePlatformSchedulingServices/9.3.
2. The following default settings for Java command line options appear in this file: java.net.preferlPv4Stack=true and
java.net.preferlPv6Addresses=false.
3. If the system is configured to use IPv6, these values must be changed to: java.net.preferlPv4Stack=false and
java.net.preferlPv6Addresses=true.

N

Remote Services

Host
machine

Port 5091

Execution Shell script
type /sas/ebiserver/Lev1/Web/Applications/RemoteServices/RemoteServices.sh

HOSTNAME.example.com

1. Execute '/sas/ebiserver/Lev1/Web/Applications/RemoteServices/RemoteServices.sh status' and verify that the application is

Validation running.
steps 2. Execute the Deployment Tester plug-in to the SAS Management Console to validate the configuration, deployment and usage of the
Remote Services application.

« SAS Remote Services needs to be restarted after each reboot of your system. The above command can be used to perform this action. Note, it is
imperative that SAS Remote Services is started before starting the web application server.

Web Application Server

Vendor JBoss

Application Server
Name

Version 5.1.2 (build: SVNTag=JBPAPP_5_1_2 date=201111102209)

JBoss

JBoss Home Dir /sas/jboss-eap-5.1/jboss-as

java version "1.6.0_30" Java(TM) SE Runtime Environment (build 1.6.0_30-b12) Java HotSpot(TM) 64-Bit Server VM (build
20.5-b03, mixed mode)

Host machine LocalHost

Java JDK

Configuration SASServer1
Port 8080

Server Log Dir /sas/jboss-eap-5.1/jboss-as/server/SASServer1/log

Configuring Your JBoss Web Application Server

When the SAS Deployment Wizard is run to install and configure the SAS software, the SAS Deployment Wizard provides the option to create a JBoss
application server configuration and to deploy the SAS web applications to that server. You have chosen auto configuration of JBoss.
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A basic JBoss configuration has been created for you that uses SAS authentication and unsecure connections. This configuration should support a small
number of users. If you need to set up a more sophisticated topology such as web server authentication or single sign-on, see the SAS 9.3 Intelligence
Platform: Security Administration Guide. For reverse proxy server and secure socket connections, see the SAS 9.3 Intelligence Platform: Web Application
Administration Guide.

JBoss Configuration Scripting Tool

New for SAS 9.3, a JBoss Application Server Configuration Scripting Tool is generated during a SAS Deployment Wizard configuration. This tool allows
you to manually execute configuration steps through a command line interface. If you selected to perform a manual configuration, you can execute the
scripting tool to create the server configuration and configure all resources equivalent to what would have been built during SAS configuration if you had
chosen to perform an automated configuration. If you performed an automated configuration, the tools can reconfigure each resource exactly as they were
configured during the SAS configuration step.

The scripting tool is located at /sas/ebiserver/Lev1/Web/Scripts/JBoss/.

If the JBoss Application Server is not installed on the machine where you ran the SAS Deployment Wizard, you can copy the Scripts directory or folder and
its contents and the ear files for your web applications to the machine where JBoss Server is installed and run the scripting tool on that machine.

It is possible to execute the individual steps and make changes to your configuration by modifying property files and rerunning steps.

Detailed instructions for the Jboss Configuration Scripting Tool can be found in the SAS Intelligence Platform: Middle-Tier Administration Guide. Before
continuing with the configuration of JBoss for SAS applications, be sure to review the JBoss Post-Installation Steps if you have not already done so.

The following list contains a summary of configuration actions the SAS Deployment Wizard has already performed:
« JBoss Server Configuration - SASServer1:

The SAS Deployment Wizard created a new JBoss configuration by copying the standard configuration named "default" found in /sas/jboss-eap-
5.1/jboss-as/server to /sas/jboss-eap-5.1/jboss-as/server/SASServer1. The SASServer1 configuration has had a number of tunings:

1. Configure the BindingService using the bindings file found at /sas/jboss-eap-5.1/jboss-as/server/SASServer1/conf/bindingservice.beans/META-
INF/bindings-jboss-beans.xml. The Bindings file contains the port settings for the JBoss server. The ports for the server are configured by
creating a ServiceBindingSet and modifying the ServiceBindingManagementObject parameters to use this new set. Here is an example of the
required changes:

_n

<bean class="org.jboss.services.binding.managed.ServiceBindingManagementObject" name="ServiceBindingManagementOb
<constructor>
<!-- The name of the set of bindings to use for this server -->
<parameter>${jboss.service.binding.set:SASServerl}</parameter>

<!-- The binding sets -->
<parameter>
<set>

<inject bean="SASServerlBindings"/>
<inject bean="PortsDefaultBindings"/>
<inject bean="Ports01Bindings"/>
<inject bean="Ports02Bindings"/>
<inject bean="Ports03Bindings"/>

</set>
</parameter>
<!-- Base binding metadata that is used to create bindings for each set -->
<parameter>
<inject bean="StandardBindings"/>
</parameter>
</constructor>

</bean>

<bean class="org.Jjboss.services.binding.impl.ServiceBindingSet" name="SASServerlBindings">
<constructor>
<parameter>SASServerl</parameter>
<parameter>${jboss.bind.address}</parameter>
<parameter>0</parameter>
<parameter>
<null/>
</parameter>
</constructor>
</bean>

2. Set ear classloader policy to isolated. Modify the "EARClassLoaderDeployer" found in the /sas/jboss-eap-5.1/jboss-
as/server/SASServer1/deployers/ear-deployer-jboss-beans.xml file. An example of the chages:

<bean class="org.jboss.deployment.EarClassLoaderDeployer" name="EARClassLoaderDeployer">
<!-- A flag indicating if ear deployments should have their own scoped
class loader to isolate their classes from other deployments.
-—>
<property name="isolated">true</property>
</bean>

3. Modify the web container (tomcat in jboss-web) configuration to suppport body encoding on URI's. Add the attribute -
useBodyEncodingForURI="true" - to the connector on port 8080 found in /sas/jboss-eap-5.1/jboss-
as/server/SASServer1/deploy/jbossweb.sar/server.xml.
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4. Create a deployment directory called "deploy_sas" in /sas/jboss-eap-5.1/jpboss-as/server/SASServer1. In addition, update the
BootstrapProfileFactory bean in /sas/jboss-eap-5.1/jboss-as/server/SASServer1/conf/bootstrap/profile.xml and the VFSCache bean in
/sasljboss-eap-5.1/jboss-as/server/SASServer1/conf/bootstrap/vfs.xml in accordance with Section "1.5.2. Adding a custom deploy folder" in the
JBoss 5.0.0 EAP "Getting Started Guide". A fragment of the BootstrapProfileFactory should look like:

<bean class="org.Jjboss.system.server.profileservice.StaticClusteredProfileFactory" name="BootstrapProfileFactory
<property name="bindingsURI">${jboss.server.home.url}conf/bindingservice.beans</property>
<property name="bootstrapURI">${jboss.server.home.url}conf/jboss-service.xml</property>
<property name="deployersURI">${jboss.server.home.url}deployers</property>
<property name="applicationURIs">
<list elementClass="java.net.URI">

<value>${jboss.server.home.url}deploy</value>

<value>${jboss.server.home.url}deploy_sas</value>

</list>
</property>

The change to VFSCache requires a new "entry" in the permanentRoots property:

<bean name="VFSCache">
<constructor factoryClass="org.jboss.virtual.spi.cache.VFSCacheFactory" factoryMethod="getInstance">

<!-- Use the CombinedVFSCache implementation -->
<parameter>org.jboss.virtual.plugins.cache.CombinedVFSCache</parameter>
</constructor>

<start ignored="true"/>
<property name="permanentRoots">
<map keyClass="java.net.URL" valueClass="org.Jjboss.virtual.spi.ExceptionHandler">

<entry>
<key>${jboss.server.home.url}ldeploy_sas</key>
<value>
<inject bean="VfsNamesExceptionHandler"/>
</value>
</entry>
</map>
</property>

<property name="realCache">
<bean class="org.jboss.virtual.plugins.cache.IterableTimedVFSCache"/>
</property>
</bean>

5. Remove the hot deployment service file. The hot deployment service is located in the hdscanner-jboss-beans.xml file found in /sas/jboss-eap-
5.1/jboss-as/server/SASServer1/deploy directory. Remove this file to disable the hot deployment feature, which is mainly used in development,
not in production servers. This will save some cpu cycles which are consumed by the scanner as it checks the deployment directories for new
deployments.

6. The SessionCookie path default has changed in JBoss 5.1 from root ("/") to the context of the requested application. In order to allow portal's to
function, the default must be set to root. The file /sas/jboss-eap-5.1/jboss-as/server/SASServer1/deploy/jbossweb.sar/context.xml requires the
SessionCookie element as a child of the <Context> element:

<Context cookies="true" crossContext="true">
<SessionCookie path="/"/>

</Context>

7. JVM options:
Set jvm options in /sas/jboss-eap-5.1/jboss-as/bin/SASServer1.sh to the following:

-Xms1024m -Xmx3096m -XX:PermSize=768m -XX:MaxPermSize=768m -d64 -XX:NewSize=128m -XX:MaxNewSize=256m -
XX:+UseConcMarkSweepGC -XX:+UseTLAB -XX:+DisableExplicitGC -XX:+CMSIncrementalMode -XX:+CMSClassUnloadingEnabled -
Dcom.sun.management.jmxremote -XX:+UseCompressedOops -Xss256k -Djava.awt.headless=true -Dsun.rmi.dgc.client.gclnterval=3600000 -
Dsun.rmi.dgc.server.gcinterval=3600000 -Dsas.scs.host=HOSTNAME.example.com -Dsas.scs.port=8080 -Dsas.container.identifier=jboss -
Dcom.sas.services.logging.disableRemoteList=true -Dcom.sas.services.logging.disableRemoteLogging=true -
Dcom.sas.log.config.ignoreContextClassLoader=true -Dsas.jms.authentication.decorator=false -Dwebreportstudio.file.cleanup.interval=60 -
Djava.net.preferlPv4Stack=true -Djava.net.preferlPv6Addresses=false -Dmulticast_udp_ip_ttI=0 -Dmulticast.address=239.11.17.8 -
Dmulticast.port=8561 -Djava.security.policy="/sas/jboss-eap-5.1/jboss-as/server/SASServer1/conf/sas.all.permissions.policy" -
Djboss.home.dir="/sas/jboss-eap-5.1/jpboss-as" -Djboss.server.home.dir="/sas/jboss-eap-5.1/jboss-as/server/SASServer1" -
Dsas.deploy.dir="/sas/jboss-eap-5.1/jboss-as/server/SASServer1/deploy_sas" -Dsas.auto.publish.port=8080 -
Dcom.sas.log.config.url=file:///sas/ebiserver/Lev1/Web/Common/LogConfig/

8. JAAS Configuration:
= Update the JAAS login configuration found in /sas/jboss-eap-5.1/jboss-as/server/SASServer1/conf/login-config.xml. The required login
module configurations are:

<application-policy name="PFS">
<authentication>
<login-module code="com.sas.services.security.login.OMILoginModule" flag="required">
<module-option name="host"> HOSTNAME.example.com </module-option>
<module-option name="port"> 8561 </module-option>
<module-option name="repository"> Foundation </module-option>
<module-option name="domain"> DefaultAuth </module-option>
<module-option name="debug"> false </module-option>
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<module-option name="trusteduser"> sastrust@saspw </module-option>
<module-option name="trustedpw"> xxxxxxxx </module-option>
</login-module>
<!-- Password for SAS Login Modules should use SAS Password Encoding -->

</authentication>
</application-policy>

<application-policy name="SASTRUSTED">
<authentication>

<login-module code="com.sas.services.security.login.TrustedLoginModule" flag="required">
<module-option name="host"> HOSTNAME.example.com </module-option>
<module-option name="port"> 8561 </module-option>
<module-option name="repository"> Foundation </module-option>
<module-option name="domain"> DefaultAuth </module-option>
<module-option name="debug"> false </module-option>
<module-option name="aliasdomain"> MidtierInternal </module-option>
<module-option name="trusteduser"> sastrust@saspw </module-option>
<module-option name="trustedpw"> xxxxxxxx </module-option>

</login-module>

<!-- Password for SAS Login Modules should use SAS Password Encoding -->

</authentication>
</application-policy>

<application-policy name="UsernamePassword">
<authentication>
<login-module code="com.platform.SASLogin.UsernamePasswordLogin" flag="required">
<module-option name="debug"> false </module-option>
</login-module>

</authentication>
</application-policy>

<application-policy name="SCS">
<authentication>
<login-module code="com.sas.services.security.login.OMILoginModule" flag="required">

<module-option
<module-option
<module-option
<module-option
<module-option
<module-option
<module-option
<module-option

name="host"> HOSTNAME.example.com </module-option>
name="port"> 8561 </module-option>
name="repository"> Foundation </module-option>
name="domain"> DefaultAuth </module-option>
name="debug"> false </module-option>
name="holdopenconnection"> true </module-option>
name="trusteduser"> sastrust@saspw </module-option>
name="trustedpw"> xxxxxxxx </module-option>

</login-module>
<!-- Password for SAS Login Modules should use SAS Password Encoding -->

</authentication>
</application-policy>

<application-policy name="webinfpltfm-encryptDBPassword">
<authentication>

<login-module code="org.jboss.resource.security.SecureldentityLoginModule" flag="required">
<module-option name="debug"> false </module-option>
<module-option name="managedConnectionFactoryName"> sas/jdbc/SharedServices </module-option>
<module-option name="username"> sasadm@saspw </module-option>
<module-option name="password"> xxxxxxxx </module-option>

</login-module>

<!-- Password for SecurelIdentityLoginModule must use JBoss Password Encoding -->

</authentication>
</application-policy>

9. Mail Session:

= The SAS Deployment Wizard has created a file named sas-mail-service.xml in /sas/jboss-eap-5.1/jboss-as/server/SASServer1/deploy to

configure the mail service. The contents of the file should contain:

<?xml version="1.0" encoding="UTF-8"?>
<server>
<mbean code="org.jboss.mail.MailService" name="java:/sas/mail/Session">
<attribute name="JNDIName">java:/sas/mail/Session</attribute>
<attribute name="Configuration">
<configuration>
<property name="mail.transport.protocol" value="smtp"/>
<property name="mail.smtp.host" value="localhost"/>
<property name="mail.smtp.port" value="25"/>
<property name="mail.debug" value="false"/>
</configuration>
</attribute>
</mbean>
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</server>

10. JMS Connection Factory:
= The JMS connection factory named SASTopicConnectionFactory is configured by adding the jndi name, sas/jms/TopicConnectionFactory,
to the JNDIBindings attribute of the default ConnectionFactory mbean found in /sas/jboss-eap-5.1/jboss-
as/server/SASServer1/deploy/messaging/connection-factories-service.xml.
= The JMS connection factory named SASQueueConnectionFactory is configured by adding the jndi name,
sas/jms/QueueConnectionFactory, to the JNDIBindings attribute of the default ConnectionFactory mbean found in /sas/jboss-eap-
5.1/jboss-as/server/SASServer1/deploy/messaging/connection-factories-service.xml.

11. JMS Queue:
= The JMS queue named AlertQueue is configured by adding the following QueueService mbean to /sas/jboss-eap-5.1/jboss-
as/server/SASServer1/deploy/messaging/destinations-service.xml.

<mbean code="org.Jjboss.jms.server.destination.QueueService"
name="jboss.messaging.destination:service=Queue, name=AlertQueue"
xmbean-dd="xmdesc/Queue-xmbean.xml">
<depends optional-attribute-name="ServerPeer">jboss.messaging:service=ServerPeer</depends>
<depends>jboss.messaging:service=PostOffice</depends>
<attribute name="JNDIName">sas/jms/AlertQueue</attribute>

</mbean>

= The JMS queue named WorkflowQueue is configured by adding the following QueueService mbean to /sas/jboss-eap-5.1/jboss-
as/server/SASServer1/deploy/messaging/destinations-service.xml.

<mbean code="org.Jjboss.jms.server.destination.QueueService"
name="jboss.messaging.destination:service=Queue, name=WorkflowQueue"
xmbean-dd="xmdesc/Queue-xmbean.xml">
<depends optional-attribute-name="ServerPeer">jboss.messaging:service=ServerPeer</depends>
<depends>jboss.messaging:service=PostOffice</depends>
<attribute name="JNDIName">sas/jms/WorkflowQueue</attribute>

</mbean>

= The JMS queue named AuditQueue is configured by adding the following QueueService mbean to /sas/jboss-eap-5.1/jboss-
as/server/SASServer1/deploy/messaging/destinations-service.xml.

<mbean code="org.jboss.jms.server.destination.QueueService"
name="jboss.messaging.destination:service=Queue, name=AuditQueue"
xmbean-dd="xmdesc/Queue-xmbean.xml">
<depends optional-attribute-name="ServerPeer">jboss.messaging:service=ServerPeer</depends>
<depends>jboss.messaging:service=PostOffice</depends>
<attribute name="JNDIName">sas/jms/AuditQueue</attribute>

</mbean>

= The JMS queue named WorkflowCommandQueue is configured by adding the following QueueService mbean to /sas/jboss-eap-
5.1/jboss-as/server/SASServer1/deploy/messaging/destinations-service.xml.

<mbean code="org.Jjboss.jms.server.destination.QueueService"
name="jboss.messaging.destination:service=Queue, name=WorkflowCommandQueue"
xmbean-dd="xmdesc/Queue-xmbean.xml">
<depends optional-attribute-name="ServerPeer">jboss.messaging:service=ServerPeer</depends>
<depends>jboss.messaging:service=PostOffice</depends>
<attribute name="JNDIName">sas/jms/WorkflowCommandQueue</attribute>

</mbean>

= The JMS queue named WorkflowEventsQueue is configured by adding the following QueueService mbean to /sas/jboss-eap-5.1/jboss-
as/server/SASServer1/deploy/messaging/destinations-service.xml.

<mbean code="org.jboss.jms.server.destination.QueueService"
name="jboss.messaging.destination:service=Queue, name=WorkflowEventsQueue"
xmbean-dd="xmdesc/Queue-xmbean.xml">
<depends optional-attribute-name="ServerPeer">jboss.messaging:service=ServerPeer</depends>
<depends>jboss.messaging:service=PostOffice</depends>
<attribute name="JNDIName">sas/jms/app/WorkflowEventsQueue</attribute>

</mbean>

= The JMS queue named scheduler.pip.resultsQueue is configured by adding the following QueueService mbean to /sas/jboss-eap-
5.1/jboss-as/server/SASServer1/deploy/messaging/destinations-service.xml.

<mbean code="org.Jjboss.jms.server.destination.QueueService"
name="jboss.messaging.destination:service=Queue, name=scheduler.pip.resultsQueue”
xmbean-dd="xmdesc/Queue-xmbean.xml">
<depends optional-attribute-name="ServerPeer">jboss.messaging:service=ServerPeer</depends>
<depends>jboss.messaging:service=PostOffice</depends>
<attribute name="JNDIName">sas/jms/scheduler.pip.resultsQueue</attribute>

</mbean>

= The JMS queue named scheduler.pip.outputQueue is configured by adding the following QueueService mbean to /sas/jboss-eap-
5.1/jboss-as/server/SASServer1/deploy/messaging/destinations-service.xml.

<mbean code="org.jboss.jms.server.destination.QueueService"
name="jboss.messaging.destination:service=Queue, name=scheduler.pip.outputQueue"
xmbean-dd="xmdesc/Queue-xmbean.xml">
<depends optional-attribute-name="ServerPeer">jboss.messaging:service=ServerPeer</depends>
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<depends>jboss.messaging:service=PostOffice</depends>
<attribute name="JNDIName">sas/jms/scheduler.pip.outputQueue</attribute>
</mbean>

= The JMS queue named scheduler.pip.jobQueue is configured by adding the following QueueService mbean to /sas/jboss-eap-5.1/jboss-
as/server/SASServer1/deploy/messaging/destinations-service.xml.

<mbean code="org.Jjboss.jms.server.destination.QueueService"
name="jboss.messaging.destination:service=Queue, name=scheduler.pip.jobQueue"
xmbean-dd="xmdesc/Queue-xmbean.xml">
<depends optional-attribute-name="ServerPeer">jboss.messaging:service=ServerPeer</depends>
<depends>jboss.messaging:service=PostOffice</depends>
<attribute name="JNDIName">sas/jms/scheduler.pip.jobQueue</attribute>

</mbean>

12. JMS Topic:
= The JMS queue named NotificationEventTopic is configured by adding the following QueueService mbean to /sas/jboss-eap-5.1/jboss-
as/server/SASServer1/deploy/messaging/destinations-service.xml.

<mbean code="org.Jjboss.jms.server.destination.TopicService"
name="jboss.messaging.destination:service=Topic,name=NotificationEventTopic"
xmbean-dd="xmdesc/Topic-xmbean.xml">
<depends optional-attribute-name="ServerPeer">jboss.messaging:service=ServerPeer</depends>
<depends>jboss.messaging:service=PostOffice</depends>
<attribute name="JNDIName">sas/jms/NotificationEventTopic</attribute>

</mbean>

= The JMS queue named SASPublishedEventTopic is configured by adding the following QueueService mbean to /sas/jboss-eap-5.1/jboss-
as/server/SASServer1/deploy/messaging/destinations-service.xml.

<mbean code="org.Jjboss.jms.server.destination.TopicService"
name="jboss.messaging.destination:service=Topic,name=SASPublishedEventTopic"
xmbean-dd="xmdesc/Topic-xmbean.xml">
<depends optional-attribute-name="ServerPeer">jboss.messaging:service=ServerPeer</depends>
<depends>jboss.messaging:service=PostOffice</depends>
<attribute name="JNDIName">sas/jms/SASPublishedEventTopic</attribute>

</mbean>

= The JMS queue named JESEventTopic is configured by adding the following QueueService mbean to /sas/jboss-eap-5.1/jboss-
as/server/SASServer1/deploy/messaging/destinations-service.xml.

<mbean code="org.Jjboss.jms.server.destination.TopicService"
name="jboss.messaging.destination:service=Topic, name=JESEventTopic"
xmbean-dd="xmdesc/Topic-xmbean.xml">
<depends optional-attribute-name="ServerPeer">jboss.messaging:service=ServerPeer</depends>
<depends>jboss.messaging:service=PostOffice</depends>
<attribute name="JNDIName">sas/jms/JESEventTopic</attribute>

</mbean>

= The JMS queue named scheduler.pip.broadcastTopic is configured by adding the following QueueService mbean to /sas/jboss-eap-
5.1/jboss-as/server/SASServer1/deploy/messaging/destinations-service.xml.

<mbean code="org.Jjboss.jms.server.destination.TopicService"
name="jboss.messaging.destination:service=Topic, name=scheduler.pip.broadcastTopic"
xmbean-dd="xmdesc/Topic-xmbean.xml">
<depends optional-attribute-name="ServerPeer">jboss.messaging:service=ServerPeer</depends>
<depends>jboss.messaging:service=PostOffice</depends>
<attribute name="JNDIName">sas/jms/scheduler.pip.broadcastTopic</attribute>

</mbean>

13. JDBC Datasource:
= The JDBC datasource named "SharedServices" must be configured into /sas/jboss-eap-5.1/jboss-as/server/SASServer1/deploy using
deployment file "SharedServices-ds.xml". Contents of SharedServices-ds.xml should look like:

<datasource>
<local-tx-datasource>
<driver-class>com.sas.tkts.TKTSDriver</driver-class>
<connection-url>jdbc:sastkts://HOSTNAME.example.com:22031</connection-url>
<connection-property name="stmtPooling">0</connection-property>
<connection-property name="constring">(DSN=SharedServices;encoding=UNICODE_FSS)</connection-property>
<security-domain>webinfpltfm-encryptDBPassword</security-domain>
<jndi-name>sas/jdbc/SharedServices</jndi-name>
</local-tx-datasource>
</datasource>

The following jars containing the driver must be copied to /sas/jboss-eap-5.1/jpboss-as/server/SASServer1/lib :

= /sas/ebiserver/Lev1/Web/Applications/SASWIPServices9.3/JDBCDrivers/icu4j.jar

= /sas/ebiserver/Lev1/Web/Applications/SASWIPServices9.3/JDBCDrivers/sas.core.jar

= /sas/ebiserver/Lev1/Web/Applications/SASWIPServices9.3/JDBCDrivers/sas.core.nls.jar

= /sas/ebiserver/Lev1/Web/Applications/SASWIPServices9.3/JDBCDrivers/sas.icons.contents.jar
= /sas/ebiserver/Lev1/Web/Applications/SASWIPServices9.3/JDBCDrivers/sas.icons.jar

= /sas/ebiserver/Lev1/Web/Applications/SASWIPServices9.3/JDBCDrivers/sas.icons.nls.jar

= /sas/ebiserver/Lev1/Web/Applications/SASWIPServices9.3/JDBCDrivers/sas.intrnet.javatools.jar
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/sas/ebiserver/Lev1/Web/Applications/SASWIPServices9.3/JDBCDrivers/sas.intrnet.javatools.nls.jar
/sas/ebiserver/Lev1/Web/Applications/SASWIPServices9.3/JDBCDrivers/sas.nls.collator.jar
/sas/ebiserver/Lev1/Web/Applications/SASWIPServices9.3/JDBCDrivers/sas.oda.tkts.jar
/sas/ebiserver/Lev1/Web/Applications/SASWIPServices9.3/JDBCDrivers/sas.oda.tkts.nls.jar
/sas/ebiserver/Lev1/Web/Applications/SASWIPServices9.3/JDBCDrivers/sas.security.sspi.jar
/sas/ebiserver/Lev1/Web/Applications/SASWIPServices9.3/JDBCDrivers/sas.svc.connection.jar
/sas/ebiserver/Lev1/Web/Applications/SASWIPServices9.3/JDBCDrivers/sas.svc.connection.nls.jar

14. Deploy Applications:

Deployment on JBoss is handled by copying the application archive to the deployment directory. With JBoss, applications can be deployed as
archives (ear files) or as exploded archives (directories). The SAS Deployment Wizard creates both ear archives and exploded archives. The
ear archives are located in the "Staging" directory while the exploded archives are located in the "Staging/exploded" directory. Either can be
used in the deployment, which is a simple copy to the proper deployment directory.

= SASWeblnfrastructurePlatformServices9.3

copy /sas/ebiserver/Lev1/Web/Staging/sas.wip.services9.3.ear /sas/jboss-eap-5.1/jboss-as/server/SASServer1/deploy_sas
= SASWeblnfrastructurePlatformApplications9.3

copy /sas/ebiserver/Lev1/Web/Staging/sas.wip.apps9.3.ear /sas/jboss-eap-5.1/jboss-as/server/SASServer1/deploy_sas
= SASWIPAdmIn9.3

copy /sas/ebiserver/Lev1/Web/Staging/sas.wip.admin9.3.ear /sas/jboss-eap-5.1/jboss-as/server/SASServer1/deploy_sas
= SASWIPResources9.3

copy /sas/ebiserver/Lev1/Web/Staging/sas.wip.resources9.3.ear /sas/jboss-eap-5.1/jboss-as/server/SASServer1/deploy_sas
= SASStoredProcess9.3

copy /sas/ebiserver/Lev1/Web/Staging/sas.storedprocess9.3.ear /sas/jboss-eap-5.1/jboss-as/server/SASServer1/deploy_sas
= SASWorkflow9.3

copy /sas/ebiserver/Lev1/Web/Staging/sas.workflow9.3.ear /sas/jboss-eap-5.1/jpboss-as/server/SASServer1/deploy_sas
= SASContentServer9.3

copy /sas/ebiserver/Lev1/Web/Staging/sas.wip.scs9.3.ear /sas/jboss-eap-5.1/jboss-as/server/SASServeri/deploy_sas
= SASFlexThemes3.4

copy /sas/ebiserver/Lev1/Web/Staging/sas.flexthemes3.4.ear /sas/jposs-eap-5.1/jboss-as/server/SASServer1/deploy_sas
= SASThemeDesigner3.4ForFlex

copy /sas/ebiserver/Lev1/Web/Staging/sas.themedesigner3.4.ear /sas/jboss-eap-5.1/jboss-as/server/SASServer1/deploy_sas
= SASThemes9.3

copy /sas/ebiserver/Lev1/Web/Staging/sas.themes.ear /sas/jboss-eap-5.1/jpboss-as/server/SASServer1/deploy_sas
= SASWebReportStudio4.3

copy /sas/ebiserver/Lev1/Web/Staging/sas.webreportstudio4.3.ear /sas/jboss-eap-5.1/jboss-as/server/SASServer1/deploy_sas
= SASPortal4.3

copy /sas/ebiserver/Lev1/Web/Staging/sas.portal4.3.ear /sas/jboss-eap-5.1/jposs-as/server/SASServer1/deploy_sas
= SASPackageViewer4.3

copy /sas/ebiserver/Lev1/Web/Staging/sas.packageviewer4.3.ear /sas/jboss-eap-5.1/jboss-as/server/SASServer1/deploy_sas
= SASBIDashboard4.3

copy /sas/ebiserver/Lev1/Web/Staging/sas.bidashboard4.3.ear /sas/jboss-eap-5.1/jboss-as/server/SASServer1/deploy_sas
= SASWebDoc9.3

copy /sas/ebiserver/Lev1/Web/Staging/sas.webdocmd9.3.ear /sas/jboss-eap-5.1/jboss-as/server/SASServer1/deploy_sas
= SASBIPortlets4.3

copy /sas/ebiserver/Lev1/Web/Staging/sas.biportlets4.3.ear /sas/jboss-eap-5.1/jboss-as/server/SASServer1/deploy_sas

« JBoss Password Encoding: JBoss provides a tool to encode plain text passwords for use by Datasource Connection Factories. The product
configurations performed have used this tool to configure at least one datasource. JBoss provides documentation at the JBoss Wiki entry
EncryptingDataSourcePasswords. A JBoss encoded password is obtained by running the following java command:

java -cp /sas/jboss-eap-5.1/jpboss-as/common/lib/jpbosssx.jar:/sas/jboss-eap-5.1/jboss-as/lib/jbosssx.jar:/sas/jboss-eap-5.1/jboss-as/common/lib/jboss-
javaee.jar:/sas/jboss-eap-5.1/jboss-as/lib/jpboss-javaee.jar:/sas/jboss-eap-5.1/jboss-as/lib/jposs-logging-spi.jar:/sas/jboss-eap-5.1/jboss-as/lib/jboss-
logging.jar:/sas/jboss-eap-5.1/jboss-as/common/lib/jpboss-connector-api_1.5_spec.jar org.jboss.resource.security.SecureldentityLoginModule
unencodedPassword

The encoded password is then used when configuring the login modules referenced by a datasource.

« SAS Password Encoding: SAS provides a tool to encode plain text passwords for use in login module configuration. The product configurations
performed have used this tool to configure at least one login module. A SAS encoded password is obtained by running the following SAS code:

PROC PWENCODE IN="unencodedPassword'; RUN;

The encoded password is generated as output and used when configuring the login modules requiring a SAS encoded password.

Starting Your JBoss Web Application Servers

The SAS Deployment Wizard has attempted to start the JBoss Web Application Server for you.
If the Server is not running then it can be started by executing the following script[s]:
* /sas/jboss-eap-5.1/jboss-as/bin/SASServer1.sh start
Usage: SASServer1.sh [start, stop] [-u jmx_admin_user -p jmx_admin_password]
When stopping a server, the SAS script becomes a wrapper for the JBoss JMX Client command "shutdown.sh". Note that access to the JMX Client
requires admin user and password to be configured when run with a default installation of Enterprise Application Platform. User and Password must
be configured in /sas/jboss-eap-5.1/jpboss-as/server/[server_configuration]/conf/props/jmx-console-users.properties (for each server configuration in

use) as documented in the JBoss Getting Started Guide, Halting the server remotely. There is no requirement to stop the server in order to update
the User and Password properties.
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SAS Web Applications

SAS Themes

Validation SAS Themes are used by SAS theme-enabled web applications. If you go to the logon screen for the Portal or Web Report Studio and see
steps images then SAS Themes are working properly.

SAS Web Infrastructure Platform

Log directory /sas/ebiserver/Lev1/Web/Logs

1. Access the Comment Service.
Validation steps 2. Log in using the sasdemo credentials provided during configuration.
3. Verify that you can add a comment.

SAS Content Server

Log file /sas/ebiserver/Lev1/Web/Logs/SASContentServer9.3.log

1. In the SAS Management Console, on the Plug-ins tab, select "+" to expand the Server Manager node.
2. Highlight the SAS Content Server.
Validation steps 3. Right mouse click this server and select Validate.
4. Log in using valid credentials for an unrestricted user defined in the SAS Metadata Server.
5. You should see a Validation Successful message.

SAS Stored Process Web Application

URL http:/HOSTNAME.example.com:8080/SASStoredProcess/do

Log file /sas/ebiserver/Lev1/Web/Logs/SASStoredProcess9.3.log

1. Access the URL provided above.
2. Log in using the sasdemo credentials provided during configuration.
Validation 3. On the Welcome page, click the "Sample: Shoe Sales by Region" link to access the custom input form for this sample stored
process.
steps 4. Select an ODS style or accept the default value, and click the "Display SAS Output" button.

5. The output from the stored process is a static table and a clickable chart. Click a bar segment on the chart to drill down to the data
for that country.

SAS Web Administration Console

URL http://HOSTNAME.example.com:8080/SASAdmin
Log file /sas/ebiserver/Lev1/Web/Logs/SASAdmMIn9.3.log

. Access the URL provided above.

. Log in using the sasadm@saspw credentials provided during configuration.

On the main page, expand the "Environment Management" folder in the tree and select the "Users" node.
Verify that "sasadm" appears in the "Authenticated Users" section in the right frame.

. Click the checkbox in the far right column of the "sasadm" row.

. Click the menu icon directly above the checkbox and select "Send E-mail".

. Enter your email address in the "To:" field and click "Send".

. Verify that you received the email.

Validation steps

PN A WN

SAS Web Report Studio

URL http://HOSTNAME .example.com:8080/SASWebReportStudio

Lo [sas/ebiserver/Lev1/Web/Logs/SASWebReportStudio4.3.log
9 For more details about how to modify your log format and to see what logging entails, see "Logging for SAS Web Applications" in the SAS

directory Intelligence Platform: Web Application Administration Guide at http://support.sas.com/93administration.

Validation
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1. Access the URL provided above.
2. Login using valid credentials defined in the SAS Metadata Server.

SAS Information Delivery Portal

URL

Log file

Validation
steps

Notes:

http://HOSTNAME.example.com:8080/SASPortal

[sas/ebiserver/Lev1/Web/Logs/SASPortal4.3.log
For more details about how to modify your log format and to see what logging entails, see "Logging for SAS Web Applications” in the SAS
Intelligence Platform: Web Application Administration Guide at http:/support.sas.com/93administration.

1. Access the URL provided above.

2. Login using the sasdemo credentials provided during configuration.

3. Since the Portal samples were installed, verify that a Home page was created and contains two portlets, My Collections and
Bookmarks.

4. Perform a search to verify that you have access to SAS content.

e The SAS Portlets are located at: /sas/ebiserver/Lev1/Web/Applications/SASPortlets4.3/Deployed
« If your network has a proxy server, you must specify the following parameters on the Application Server start-up command so that syndication
channels and the URL Display Portlet can access content outside of your network.
o -Dhttp.proxyHost=host
o -Dhttp.proxyPort=port

SAS Bl Portlets

Log file

Validation
steps

Notes:

[sas/ebiserver/Lev1/Web/Logs/SASBIPortlets4.3.log
For more details about how to modify your log format and to see what logging entails, see "Logging for SAS Web Applications” in the SAS
Intelligence Platform: Web Application Administration Guide at http:/support.sas.com/93administration.

1. Login to the portal.
2. Add the SAS Navigator Portlet to a portal page.
3. Navigate to different locations.

* SAS reports must be defined in order to use the SAS Report Portlet
e SAS stored processes must be defined in order to use the SAS Stored Process Portlet
e SAS dashboards must be defined in order to use the SAS Bl Dashboard Portlet

SAS Bl Dashboard

URL

Log

Validation
Steps

http://support.sas.com/resources/thirdpartysupport/v93/appservers/jbossunix.html

http://HOSTNAME.example.com:8080/SASBIDashboard

[sas/ebiserver/Lev1/Web/Logs/SASBIDashboard4.3.log
For more details about how to modify your log format and to see what logging entails, see "Logging for SAS Web Applications" in the SAS
Intelligence Platform: Web Application Administration Guide at http://support.sas.com/93administration.

N

. Grant the user "SAS Demo User" access to SAS Bl Dashboard 4.3. In SAS Management Console, on the Plug-ins tab, select the User
Manager node.

. Right select "Bl Dashboard Administrators" and select Properties.

. Select the "Members" tab

Double click on SAS Demo User to add it to the group.

Select OK.

. Access the URL provided above.

. Login using the "sasdemo" credentials provided during configuration.

. Select Manage Dashboards.

. Select New Indicator Data.

10. Enter a name for the Indicator Data, and then select OK.

11. Select Data source: SQL query. Enter this SQL query: select * from sashelp.prdsale. Select Apply Query Changes.

12. File > Save. Navigate to Products/Bl Dashboard 4.3/ModelConfigs, and select Save.

13. File > New > Indicator

14. Enter a Name for the Indicator. Select Display type: Pie Chart. Select Browse, navigate to the indicator data just created, and select

OK. Select OK again.

15. Select Category value: COUNTRY. Select Response value: ACTUAL.

16. File > Save. Navigate to Products/Bl Dashboard 4.3/IndicatorDefinitions, and select Save.

17. File > New > Dashboard

18. Enter a Name for the Dashboard, and select OK.

19. In the Objects pane, navigate to Products/Bl Dashboard 4.3/IndicatorDefinitions. Drag-n-drop the indicator just created onto the

dashboard.

©CONOOAWN

1517


http://hostname.example.com:8080/SASPortal
http://support.sas.com/sas/ebiserver/Lev1/Web/Logs/SASPortal4.3.log
http://support.sas.com/93administration
http://support.sas.com/sas/ebiserver/Lev1/Web/Logs/SASBIPortlets4.3.log
http://support.sas.com/93administration
http://hostname.example.com:8080/SASBIDashboard
http://support.sas.com/sas/ebiserver/Lev1/Web/Logs/SASBIDashboard4.3.log
http://support.sas.com/93administration

5/26/2017 Configuration Guidelines and Details

20. File > Save. Navigate to Products/Bl Dashboard 4.3/DashboardConfigs, and select Save.

21. View > Go to Dashboard Viewer

22. Verify that you have access to this dashboard by adding the Bl Dashboard Portlet to a Portal page.

23. Documentation at http://support.sas.com/documentation/onlinedoc/bidashboard/index.html is available to assist you.

SAS Flex Application Themes

Validation SAS Flex Themes are used by SAS theme-enabled Flex applications. If after logging into SAS Bl Dashboard you see images then SAS
steps Flex Themes are working properly.

Validation SAS Theme Designer for Flex is accessible from http://HOSTNAME.example.com:8080/SASThemeDesignerForFlex.
steps In order to use this application, you must be a member of the role "Theme Designer for Flex: Administration".

SAS Help Viewer for Midtier Applications

URL http://HOSTNAME.example.com:8080/SASWebDoc

Validation Use the URL above and examine the Installed Products Page, if there were any errors configuring help content, they will be reported on
steps that page.

Web Application Custom Content

If you wish to add custom content into SAS web applications, you may do so by placing your custom content into the appropriate custom content directory
structure, and then running the SAS Deployment Manager to rebuild web applications. Note that some SAS web applications do not support custom
content. The custom content root directory for a given web application is

/sas/ebiserver/Levl/Web/Common/Server Name/Application Name/CustomContent
For example,

/sas/ebiserver/Levl/Web/Common/SASServerl/SASWebReportStudio4.3/CustomContent

Within that directory, there are subdirectories (for example, ears or wars) corresponding to specific archive types (ear and war files, respectively). Under
the archive type directories, there are subdirectories for each specific archive—these are the root directories for each archive within the application.
Custom content should be placed in the archive's directory tree corresponding to where the content should appear within the archive.

For example, to add the ear addon.xml file into the addons directory in the sas.webreportstudio ear file, create the

.../CustomContent/ears/sas.webreportstudio/addons

directory, and place ear addon.xml in it. Our process knows which war files are contained within ear files, so if you want to add war addon.jar into
the WEB-INF/11ib directory in the sas.webreportstudio war file within the sas.webreportstudio ear file, then create

.../CustomContent/wars/sas.webreportstudio/WEB-INF/1lib
directory, and place war addon.jarinit.
Once all your custom content is ready to be consumed, run the SAS Deployment Manager and choose to rebuild web applications. Doing so will rebuild the

web applications, inserting the custom content into the archives under the appropriate paths. Note that if custom content has the same path and name of
content normally included in the archive, then the custom content takes precedence.

Obtaining Additional Information

Additional SAS Intelligence Platform documentation is available from the SAS 9.3 administration documentation web site.

There may be additional configuration steps required for your SAS Foundation software. Consult the SAS Foundation Configuration instructions available
for your operating system for product-specific post-installation steps. The configuration instructions are available from the SAS Install Center web site.

Backing up your SAS Metadata Server

Your metadata server is configured to perform unassisted metadata server backups and roll-forward recovery to a specified point in time. The first backup
was taken immediately after the completion of the SAS Metadata Server configuration step. Because roll-forward recovery is configured, all metadata
updates made by subsequent configuration steps will be captured in the server's journal file. When your installation is complete, you can choose to execute
an ad hoc server backup immediately or wait for the next scheduled backup to occur.

Server backups are requested in the Server Backup node of the SAS Management Console Metadata Manager. Right-click the Server Backup folder and
select Run Backup Now from the menu. The default backup configuration performs nightly server backups at 1 a.m. To modify the backup schedule, select
Server Backup->Backup Schedule.

Caution: The server backup facility only backs up your metadata server. This includes SAS metadata repositories and metadata server configuration files.
It does not include other SAS Intelligence Platform configuration directories or SAS software. You will need to make regular system backups as well as
metadata server backups in order to restore your SAS configuration. Metadata server backups should be scheduled to occur just before system backups
so that each system backup has a timely metadata server backup.
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From the Server Backup node, administrators can also:

« monitor the backup history
« modify the default backup configuration
« execute a roll-forward recovery of the metadata server from a selected backup.

Regular metadata server backups using SAS backup tools are crucial to ensuring the health of your SAS 9.3 Intelligence Platform configuration, but they
are just one part of backing up a SAS Intelligence Platform configuration. To devise a backup strategy for your entire SAS Intelligence Platform
configuration, see "Best Practices for Backing Up and Restoring Your System" in the SAS Intelligence Platform: System Administration Guide at
http://support.sas.com/93administration.
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